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SIEMENS AG. 

SIMETIC S7 3964(R)/RK512 
지원버전 OS V4.0 이상  

XDesignerPlus 4.0.0.0 이상 

CONTENTS 

본사 ㈜M2I의 “Touch Operation Panel(M2I TOP) Series”를 사용해주시

는 고객님께 감사드립니다. 본 매뉴얼을 읽고 “TOP–외부장치”의 접속 

방법 및 절차를 숙지해 주십시오. 

 

1. 시스템 구성 2 페이지 

 

 

 

접속에 필요한 기기, 각 기기의 설정, 케이블, 구성 가능한 시스

템에 대해 설명합니다. 

본 절을 참조하여 적절한 시스템을 선정하십시오. 

2. TOP 기종과 외부 장치 선택  3 페이지 

 TOP 기종과 외부 장치를 선택합니다. 

3. 시스템 설정 예제 4 페이지 

 본 기기와 해당 외부 단말기의 통신 접속을 위한 설정 예제를 

설명 합니다.  

“1. 시스템 구성”에서 선택한 시스템에 따라 예제를 선택 하십시

오. 

4. 통신 설정 항목 12 페이지 

 TOP 통신 설정 하는 방법에 대해서 설명합니다.  

외부 장치의 설정이 바뀔 경우 본 장을 참조 하여 TOP의 설정도 

외부 장치와 같게 설정하십시오. 

5. 케이블 표 15 페이지 

 접속에 필요한 케이블 사양에 대해 설명합니다. 

“1. 시스템 구성”에서 선택한 시스템에 따라 적합한 케이블 사양

을 선택 하십시오. 

6. 지원 어드레스 17 페이지 

 본 절을 참조하여 외부 장치와 통신 가능한 어드레스를 확인하

십시오. 
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1. 시스템 구성 

TOP와 “SIEMENS AG. – SIEMETIC S7 3964(R)/RK512”의 시스템 구성은 아래와 같습니다. 

 

시리즈 CPU Link I/F 통신 방식 시스템 설정 케이블 

SIMETIC 

S7-300 

CPU312 IFM 

CPU313 

CPU314  

CPU314 IFM  

CPU315  

CPU315(F)-2 DP  

CPU315(F)-2 PN/DP  

CPU316  

CPU316-2 DP  

CPU317-2 DP 

CPU317F-2 

CPU318-2  

CPU317-2 PN/DP  

CPU319-3 PN/DP 

CPU614 

CPU388 

CP341 RS-232C 
3.1 설정 예제 1 

( 4 페이지 ) 

5.1 케이블 표 1 

( 15 페이지 ) 

CP341 RS-422 ( 4 wire ) 
3.2 설정 예제 2 

( 8 페이지 ) 

5.2 케이블 표 2 

( 16 페이지 ) 

SIMETIC 

S7-400 

CPU412-1 

CPU412-2 DP 

CPU413-1 

CPU413-2 DP 

CPU414-1 

CPU414-2 DP 

CPU414-3 DP 

CPU416-1 

CPU416-2 DP 

CPU416-3 DP 

CPU417-4 

CPU414-3PN/DP  

CPU416-3PN/DP 

CPU417 

CPU486 

CP441-2 

RS-232C 
3.1 설정 예제 1 

( 4 페이지 ) 

5.1 케이블 표 1 

( 15 페이지 ) 

RS-422 ( 4 wire ) 
3.2 설정 예제 2 

( 8 페이지 ) 

5.2 케이블 표 2 

( 16 페이지 ) 

 

 

 

■ 연결 구성 

 

ㆍ1 : 1(TOP 1 대와 외부 장치 1 대) 연결  
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2. TOP 기종과 외부 장치 선택 

TOP와 연결 될 외부 장치를 선택 합니다. 

 

 

 

설정 사항 내용 

TOP 

Series 

PLC와 연결할 TOP의 시리즈 명칭을 선택합니다. 

설정 내용을 Download 하기 전에 TOP의 시리즈에 따라 아래 표에 명시된 버전의 OS를 인스톨 

하십시오. 

시리즈 버전 명칭 

XTOP / HTOP V4.0 
 

Name TOP 제품 모델명을 선택합니다. 

외부 장치 

제조사 
TOP와 연결할 외부 장치의 제조사를 선택합니다. 

“SIEMENS AG.”를 선택 하십시오. 

PLC 

TOP에 연결 될 외부 장치의 모델 시리즈를 선택 합니다. 

“SIEMETIC S7 3964(R)/RK512” 를 선택 하십시오.  

연결을 원하는 외부 장치가 시스템 구성 가능한 기종인지 1장의 시스템 구성에서 확인 하시기 

바랍니다. 
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3. 시스템 설정 예제 

TOP와 SIEMETIC S7의 통신 인터페이스 설정을 아래와 같이 권장 합니다. 

 

3.1 설정 예제 1 

 

구성한 시스템을 아래와 같이 설정 합니다. 

항목 TOP SIEMETIC S7 시리즈 비고 

시리얼레벨 (포트/채널) RS-232C (COM2) RS-232C 유저 설정 

시리얼보우레이트 [BPS] 76800 유저 설정 

시리얼데이터비트 [Bit] 8 유저 설정 

시리얼스톱비트 [Bit] 1 유저 설정 

시리얼패리티비트 [Bit] EVEN 유저 설정 

동작모드 RK512 유저 설정 

 

 

((1) XDesignerPlus 설정 

[프로젝트 > 프로젝트 설정]에서 아래 내용을 설정 후, TOP 기기로 설정 내용을 다운로드 합니다.. 

 

 

■ [ 프로젝트 > 프로젝트 속성 > 프로젝트 > 설정 > TOP Name ]. 

TOP 기기의 통신 인터페이스를 설정 합니다. 

– 우측 윈도우에서 [ HMI 설정 > HMI 설정 사용 체크 > 장치 관리자 ]  

 

 
■ 외부 장치 설정 

“SIEMETIC S7 3964(R)/RK512” 통신 드라이버의 옵션을 설정 합니다. 

 

– PLC 노드 번호: 외부 장치의 Node Address 를 입력 합니다. 
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(2) 외부 장치 설정 

SIEMETIC S7 Ladder Software [STEP 7]를 사용하여 아래와 같이 설정 하십시오. 본 예제에서 설명된 내용보다 더 자세한 설정법은 

PLC 사용자 매뉴얼을 참조하십시오. 
 

 
PLC의 노드 어드레스를 “Highest Node Address”보다 작게 설정 하십시오.  

 

1. [SIMETIC Manager]의 메인메뉴 상단 바에서 [New Project]를 통해 새 프로젝트를 생성합니다. 

2. 메뉴 [Insert] > [Station] > [1 SIMETIC 400 Station] 혹은 [2 SIMETIC 300 Station]을 선택합니다.  CPU 추가 

3. 추가된 “[SIMETIC 400(1)]” 혹은 [SIMETIC 300(1)]  CPU 더블클릭 > 해당 CPU의 [Hardware] 더블클릭” 합니다.  [HW Config] 

윈도우가 새로 나타납니다 

4. [HW Config] 윈도우의 왼쪽 트리 창에서 “[SIMATIC 400] > [RACK-400]” 혹은 “[SIMATIC 300] > [RACK-300]” 을 열어 사용하는 

Base unit 모델을 선택 후, 윈도우 오른쪽 하단으로  Drag & Drop 하여 등록 합니다. 

5. [SIMATIC 400] > [PS-400] 혹은 [PS-300] 을 선택하여 사용하는 전원 유닛을 선택하여 현재 Rack에 Drag & Drop 합니다. 

6. [SIMATIC 400] > [CPU-400] 혹은 [CPU-300] 을 선택하여 사용하는 CPU 유닛을 선택하여 현재 Rack에 Drag & Drop 합니다. 

(만약 [Properties – PROFIBUS interface DP] 윈도우가 새로 표시 될 경우 [Cancel]키를 눌러 윈도우를 종료 합니다.) 

7. [SIMATIC 400] > [CP-400] 혹은 [CP-300]을 선택하여 사용하는 CPU 유닛을 선택하여 현재 Rack에 Drag & Drop 합니다. 

 

8. 등록한 CPU 명칭을 더블 클릭합니다.  해당 CPU의 [Properties] 윈도우가 새로 나타납니다. 

9. [Properties] 윈도우의 [General]탭에서 [Interface] > [Properties] 를 선택하여 [Properties – MPI interface CPU xxx-xxx ]윈도우를 팝

업 시킵니다. 

10. [Properties – MPI interface CPU xxx-xxx ]윈도우의 [Parameter] 탭에서 MPI 포트의 국번(Address)와 전송 속도[Transmission rate]

를 아래와 같이 설정 합니다. ( 전송 속도 변경 : [Properties]를 클릭 > [Properties] 윈도우의 [Network Settings]탭 ) 

  
 

항목 내용 

국번 (Address) 2 ( Default ) 

전송 속도(Transmission rate) 187500bps ( Default ) 

11. [OK] 를 클릭 하여 [Properties] 윈도우 상에서 설정 내용을 저장 합니다. 

12. [HW Config] 윈도우 상에서 이전에 등록한 시리얼 통신 유닛 을 더블 클릭 합니다.  [Properties] 윈도우가 새로 나타납니다. 
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13. [Properties] > [Addresses] 탭에서 [Inputs]>[Start] 에서 Input Start Address를 확인 합니다. 

 

14. [Properties] 윈도우 하단의 [Parameter…]키를 클릭합니다.  

 [Assigning Parameter to Point-To-Point Connections] 윈도우가 새로 나타납니다. 

 

15. [Assigning Parameter to Point-To-Point Connections] 윈도우에서 [Protocol]을 [RK512]로 설정 합니다. 

16. 화면 중간의 [Protocol] box를 더블 클릭하여 [RK512] 프로토콜 세부설정을 아래와 같이 입력 합니다. 

 
 

항목 설정 내용 항목  설정 내용 

With Block Check Check Stop Bits 1 

Use Default Values Check Parity Even 

Transmission Rate 76800 bps Priority Low 

17. [File] > [Save]로 설정 내용 저장 후 [Assigning Parameter to Point-To-Point Connections] 윈도우를 종료 합니다. 

18. [Station] > [Save and Compile]을 선택하여 하드웨어 설정 사항을 저장합니다. 
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19. [SIMATIC Manager] 윈도우의 프로젝트 트리에서 [HW Config 상에서 등록한 CPU 명칭]을 선택하고 [Blocks]을 선택 한 후에 

 [OB1]을 더블 클릭 합니다. ([Properties]윈도우가 팝업 될 경우 [ok]를 클릭합니다.)  Ladder software [LAD/STL/FBD] 실행 

20. Ladder software [LAD/STL/FBD] 에서 파라미터를 설정 합니다. [Language for selected Blocks] > [STL] 혹은 [LAD]에 따라 아래 

예제 중 한가지를 택일 하여 설정 하십시오. 

[Language for selected Blocks] > [STL] [Language for selected Blocks] > [LAD] 

 

 

(예) [Libraries] > [CP 341] > [FB7 P_RCV_RK CP341] 

CALL“P_RCV_RK” , DB7 

EN_R 

R 

LADDR 

DB_NO 

DBB_NO 

L_TYP 

L_NO 

L_OFFSET 

L_CF_BYT 

L_CF_BIT 

NDR 

ERROR 

LEN 

STATUS 

:=TRUE 

:=FALSE 

:=256 

:= 

:= 

:= 

:= 

:= 

:= 

:= 

:= 

:= 

:= 

:= 

◆ 설명 

항목 내용 

DB7 P_RCV_RK 이 통신 수신을 위해 사용하게 될 DB 번호 

EN_R ‘EN_R’ 을  ON으로 해야 통신이 가능합니다. 

R 리셋 입력 

LADDR 13번 순서에서 확인한 Input Start Address 번호 

DB_NO 사용할 DB를 입력 합니다. 할당해 준 영역만 통신으로 읽고 쓸 수 있습니다. 

21. [Station] > [Save and Compile]을 선택하여 컴파일 후, PLC로 설정 내용을 다운로드 합니다.
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3.2 설정 예제 2 

 

구성한 시스템을 아래와 같이 설정 합니다. 

항목 TOP SIEMETIC S7 시리즈 비고 

시리얼레벨 (포트/채널) RS-422 ( 4 wire, COM2 ) RS-422 유저 설정 

시리얼보우레이트 [BPS] 76800 유저 설정 

시리얼데이터비트 [Bit] 8 유저 설정 

시리얼스톱비트 [Bit] 1 유저 설정 

시리얼패리티비트 [Bit] EVEN 유저 설정 

동작모드 RK512 유저 설정 

 

 

(1) XDesignerPlus 설정 

[프로젝트 > 프로젝트 설정]에서 아래 내용을 설정 후, TOP 기기로 설정 내용을 다운로드 합니다.. 

 

 

■ [ 프로젝트 > 프로젝트 속성 > 프로젝트 > 설정 > TOP Name ]. 

TOP 기기의 통신 인터페이스를 설정 합니다. 

– 우측 윈도우에서 [ HMI 설정 > HMI 설정 사용 체크 > 장치 관리자 ]  

 

 
■ 외부 장치 설정 

“SIEMETIC S7 3964(R)/RK512” 통신 드라이버의 옵션을 설정 합니다. 

 

– PLC 노드 번호: 외부 장치의 Node Address 를 입력 합니다. 
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(2) 외부 장치 설정 

SIEMETIC S7 Ladder Software [STEP 7]를 사용하여 아래와 같이 설정 하십시오. 본 예제에서 설명된 내용보다 더 자세한 설정법은 

PLC 사용자 매뉴얼을 참조하십시오. 
 

 
PLC의 노드 어드레스를 “Highest Node Address”보다 작게 설정 하십시오.  

 

1. [SIMETIC Manager]의 메인메뉴 상단 바에서 [New Project]를 통해 새 프로젝트를 생성합니다. 

2. 메뉴 [Insert] > [Station] > [1 SIMETIC 400 Station] 혹은 [2 SIMETIC 300 Station]을 선택합니다.  CPU 추가 

3. 추가된 “[SIMETIC 400(1)]” 혹은 [SIMETIC 300(1)]  CPU 더블클릭 > 해당 CPU의 [Hardware] 더블클릭” 합니다.  [HW Config] 

윈도우가 새로 나타납니다 

4. [HW Config] 윈도우의 왼쪽 트리 창에서 “[SIMATIC 400] > [RACK-400]” 혹은 “[SIMATIC 300] > [RACK-300]” 을 열어 사용하는 

Base unit 모델을 선택 후, 윈도우 오른쪽 하단으로  Drag & Drop 하여 등록 합니다. 

5. [SIMATIC 400] > [PS-400] 혹은 [PS-300] 을 선택하여 사용하는 전원 유닛을 선택하여 현재 Rack에 Drag & Drop 합니다. 

6. [SIMATIC 400] > [CPU-400] 혹은 [CPU-300] 을 선택하여 사용하는 CPU 유닛을 선택하여 현재 Rack에 Drag & Drop 합니다. 

(만약 [Properties – PROFIBUS interface DP] 윈도우가 새로 표시 될 경우 [Cancel]키를 눌러 윈도우를 종료 합니다.) 

7. [SIMATIC 400] > [CP-400] 혹은 [CP-300]을 선택하여 사용하는 CPU 유닛을 선택하여 현재 Rack에 Drag & Drop 합니다. 

 

8. 등록한 CPU 명칭을 더블 클릭합니다.  해당 CPU의 [Properties] 윈도우가 새로 나타납니다. 

9. [Properties] 윈도우의 [General]탭에서 [Interface] > [Properties] 를 선택하여 [Properties – MPI interface CPU xxx-xxx ]윈도우를 팝

업 시킵니다. 

10. [Properties – MPI interface CPU xxx-xxx ]윈도우의 [Parameter] 탭에서 MPI 포트의 국번(Address)와 전송 속도[Transmission rate]

를 아래와 같이 설정 합니다. ( 전송 속도 변경 : [Properties]를 클릭 > [Properties] 윈도우의 [Network Settings]탭 ) 

  
 

항목 내용 

국번 (Address) 2 ( Default ) 

전송 속도(Transmission rate) 187500bps ( Default ) 

11. [OK] 를 클릭 하여 [Properties] 윈도우 상에서 설정 내용을 저장 합니다. 

12. [HW Config] 윈도우 상에서 이전에 등록한 시리얼 통신 유닛 을 더블 클릭 합니다.  [Properties] 윈도우가 새로 나타납니다. 
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13. [Properties] > [Addresses] 탭에서 [Inputs]>[Start] 에서 Input Start Address를 확인 합니다. 

 

14. [Properties] 윈도우 하단의 [Parameter…]키를 클릭합니다.  

 [Assigning Parameter to Point-To-Point Connections] 윈도우가 새로 나타납니다. 

 

15. [Assigning Parameter to Point-To-Point Connections] 윈도우에서 [Protocol]을 [RK512]로 설정 합니다. 

16. 화면 중간의 [Protocol] box를 더블 클릭하여 [RK512] 프로토콜 세부설정을 아래와 같이 입력 합니다. 

 
 

항목 설정 내용 항목  설정 내용 

With Block Check Check Stop Bits 1 

Use Default Values Check Parity Even 

Transmission Rate 76800 bps Priority Low 

17. [File] > [Save]로 설정 내용 저장 후 [Assigning Parameter to Point-To-Point Connections] 윈도우를 종료 합니다. 

18. [Station] > [Save and Compile]을 선택하여 하드웨어 설정 사항을 저장합니다. 
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19. [SIMATIC Manager] 윈도우의 프로젝트 트리에서 [HW Config 상에서 등록한 CPU 명칭]을 선택하고 [Blocks]을 선택 한 후에 

 [OB1]을 더블 클릭 합니다. ([Properties]윈도우가 팝업 될 경우 [ok]를 클릭합니다.)  Ladder software [LAD/STL/FBD] 실행 

20. Ladder software [LAD/STL/FBD] 에서 파라미터를 설정 합니다. [Language for selected Blocks] > [STL] 혹은 [LAD]에 따라 아래 

예제 중 한가지를 택일 하여 설정 하십시오. 

[Language for selected Blocks] > [STL] [Language for selected Blocks] > [LAD] 

 

 

(예) [Libraries] > [CP 341] > [FB7 P_RCV_RK CP341] 

CALL“P_RCV_RK” , DB7 

EN_R 

R 

LADDR 

DB_NO 

DBB_NO 

L_TYP 

L_NO 

L_OFFSET 

L_CF_BYT 

L_CF_BIT 

NDR 

ERROR 

LEN 

STATUS 

:=TRUE 

:=FALSE 

:=256 

:= 

:= 

:= 

:= 

:= 

:= 

:= 

:= 

:= 

:= 

:= 

◆ 설명 

항목 내용 

DB7 P_RCV_RK 이 통신 수신을 위해 사용하게 될 DB 번호 

EN_R ‘EN_R’ 을  ON으로 해야 통신이 가능합니다. 

R 리셋 입력 

LADDR 12번 순서에서 확인한 Input Start Address 번호 

DB_NO 사용할 DB를 입력 합니다. 할당해 준 영역만 통신으로 읽고 쓸 수 있습니다. 

21. [Station] > [Save and Compile]을 선택하여 컴파일 후, PLC로 설정 내용을 다운로드 합니다. 
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4. 통신 설정 항목 

통신 설정은 XDesignerPlus 혹은 TOP 메인 메뉴에서 설정 가능 합니다. 통신 설정은 외부 장치와 동일하게 설정 해야 합니다. 

 

4.1 XDesignerPlus 설정 항목 

아래 창의 내용을 나타내기 위해서 [프로젝트 > 프로젝트 속성]을 선택 하십시오. 

 

 

■ [ 프로젝트 > 프로젝트 속성 > 프로젝트 > 설정 > TOP Name ]. 

TOP 기기의 통신 인터페이스를 설정 합니다. 

– 우측 윈도우에서 [ HMI 설정 > HMI 설정 사용 체크 > 장치 관리자 ]  

 

 

– 우측 윈도우에서 [ HMI 설정 > HMI 설정 사용 체크 > PLC 설정]  

 

 

■ 외부 장치 설정 

“SIEMETIC S7 3964(R)/RK512” 통신 드라이버의 옵션을 설정 합니다. 

 

  

 

■ 통신 인터페이스 설정 

항목 내용 

신호레벨 외부 장치 – TOP 간 시리얼 통신 방식을 선택 합니다. (COM 1은 RS-232C 만을 제공 합니다.) 

보우레이트 외부 장치 – TOP 간 시리얼 통신 속도를 선택합니다. 

데이터 비트 외부 장치 – TOP 간 시리얼 통신 데이터 비트를 선택합니다. 

정지 비트 외부 장치 – TOP 간 시리얼 통신 정지 비트를 선택합니다. 

패리티 비트 외부 장치 – TOP 간 시리얼 통신 패리티 비트 확인 방식을 선택합니다. 

타임 아웃[ x100 mSec ] TOP가 외부 장치로부터의 응답을 기다리는 시간을 [ 0 – 5000 ] x 1 mSec  로 설정합니다. 

송신 지연 시간[ x10 mSec] 

수신 대기 시간[ x10 mSec] 

TOP가 외부 장치로부터 응답 수신 – 다음 명령어 요청 전송 간에 대기하는 시간을 [ 0 – 5000 ] x 1 

mSec  로 설정합니다. 

PLC 국번. [0~65535] 상대 기기의 국번입니다.  [ 0 – 65535 ] 사이의 값을 선택합니다. 
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4.2 TOP 메인 메뉴 설정 항목 

- 전원을 리셋 중 부저음이 울릴 때 LCD 상단 1점을 터치하여 “TOP 관리 메인” 화면으로 이동합니다. 

- TOP에서 드라이버 인터페이스 설정은 아래의 Step1 → Step2 내용을 따라 설정합니다. 

(Step 1.에서 “TOP COM 2/1 설정”을 누르시면 Step2.에서 설정을 바꾸실 수 있습니다.) 

 

 

 

 

Step 1. [ PLC 설정 ] – 드라이버 인터페이스를 설정 합니다. 

PLC 설정 

PLC 국번 : 00 통신 인터페이스 설정 

타임아웃 : 1000 [mSec]  

송신전 지연 시간 : 0 [mSec]  

TOP COM 2/1 : RS – 232C , 76800 , 8 , 1 , NONE  

TOP COM 2/1 설정  통신 진단  

Step 1–Reference. 

항목 내용 

PLC 국번. [0~65535] 상대 기기의 국번입니다.  [ 0 – 65535 ] 사이의 값을 선택합니다. 

타임아웃 [ x1 mSec ] TOP가 외부 장치로부터의 응답을 기다리는 시간을 [ 0 – 5000 ] x 1 mSec 로 설정합니다. 

송신전 지연시간 [ x1 mSec ] 
TOP가 외부 장치로부터 응답 수신 – 다음 명령어 요청 전송 간에 대기하는 시간을 [ 0 – 

5000 ] x 1 mSec 로 설정합니다. 

TOP COM 2/1 TOP가 외부 장치에 대한 인터페이스 설정 입니다. 

 

 

Step 2. [ PLC 설정 ] >[ TOP COM2/COM1 설정 ] – 해당 포트의 시리얼 파라미터를 설정 합니다. 

포트 설정 

* 시리얼 통신 COM 1 포트 

 + COM-1 Port 통신 인터페이스 설정 

  - 보우레이트 : 76800 [BPS]  

  - 데이터 비트 : 8 [BIT]  

  - 정지 비트 : 1 [BIT]  

  - 페리티 비트 : NONE [BIT]  

  - 신호레벨 : RS – 232C  

 + COM-2 Port COM 2 포트 

  - 보우레이트 : 76800 [BPS] 통신 인터페이스 설정 

  - 데이터 비트 : 8 [BIT]  

  - 정지 비트 : 1 [BIT]  

  - 페리티 비트 : NONE [BIT]  

  - 신호 레벨 : RS – 232C  

Step 2-Reference. 

항목 내용 

보우레이트 외부 장치 – TOP 간 시리얼 통신 속도를 선택합니다. 

데이터비트 외부 장치 – TOP 간 시리얼 통신 데이터 비트를 선택합니다. 

정지 비트 외부 장치 – TOP 간 시리얼 통신 정지 비트를 선택합니다. 

패리티 비트 외부 장치 – TOP 간 시리얼 통신 패리티 비트 확인 방식을 선택합니다. 

신호 레벨 외부 장치 – TOP 간 시리얼 통신 방식을 선택 합니다. 
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4.3 통신 진단 

■ TOP – 외부 장치 간 인터페이스 설정 상태를 확인  

- TOP의 전원을 리셋 하면서 LCD 창의 상단을 클릭하여 메뉴 화면으로 이동한다. 

- [통신 설정] 에서 사용 하고자 하는 포트[ COM 2 or COM 1 ] 설정이 외부 기기의 설정 내용과 같은지 확인한다 

■ 포트 통신 이상 유무 진 단 

- PLC 설정 > TOP [ COM 2 혹은 COM 1 ] “통신 진단”의 버튼을 클릭한다. 

- 화면 상에 Diagnostics 다이얼로그 박스가 팝업 되며, 박스의 3번 항에 표시된 내용에 따라 진단 상태를 판단한다. 

OK! 통신 설정 정상 

Time Out Error! 통신 설정 비 정상 

- 케이블 및 TOP/외부 장치의 설정 상태를 에러 (참조 : 통신 진단 시트 ) 

■ 통신 진단 시트  

- 외부 단말기와 통신 연결에 문제가 있을 경우 아래 시트의 설정 내용을 확인 바랍니다. 

Designer Version  O.S Version  

항목 내용 확인 

시스템 구성 CPU 명칭  OK NG 

 통신 상대 포트 명칭  OK NG 

 시스템 연결 방법 1:1 1:N N:1 OK NG 

접속 케이블 케이블 명칭  OK NG 

PLC 설정 설정 국번  OK NG 

 Serial baud rate                               [BPS] OK NG 

 Serial data bit                               [BIT] OK NG 

 Serial Stop bit                               [BIT] OK NG 

 Serial parity bit                               [BIT] OK NG 

 어드레스 할당 범위  OK NG 

TOP 설정 설정 포트 COM 1 COM 2 OK NG 

 드라이버 명칭  OK NG 

 상대 국번 Project Property설정  OK NG 

  통신 진단 시  OK NG 

 Serial baud rate                               [BPS] OK NG 

 Serial data bit                               [BIT] OK NG 

 Serial Stop bit                               [BIT] OK NG 

 Serial parity bit                               [BIT] OK NG 
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5. 케이블 표  

본 Chapter는 TOP와 해당 기기 간 정상 통신을 위한 케이블 다이어그램을 소개 합니다. (본 절에서 설명되는 케이블 다이어그램은 

“SIEMENS AG.”의 권장사항과 다를 수 있습니다) 

 

5.1 케이블 표 1 

 

■ 1 : 1 연결 

 

(A) XTOP COM 2 포트(9핀) 

XTOP COM2 
케이블 접속 

외부 장치 

핀 배열*주1) 신호명 핀번호 핀번호 신호명 핀 배열*주1) 

 

통신 케이블 커넥터 

전면 기준, 

D-SUB 9 Pin 

male(수, 볼록) 

CD 1  1 CD 

 

통신 케이블 커넥터 

전면 기준, 

D-SUB 9 Pin 

male(수, 볼록) 

RD 2 2 RD 

SD 3 3 SD 

DTR 4 4 DTR 

SG 5 5 SG 

DSR 6 6 DSR 

RTS 7 7 RTS 

CTS 8 8 CTS 

 9 9 RI 

*주1) 핀 배열은 케이블 접속 커넥터의 접속면에서 본 것 입니다. 

 

(B) XTOP COM 2 포트(15핀) 

XTOP COM2 
케이블 접속 

외부 장치 

핀 배열*주1) 신호명 핀번호 핀번호 신호명 핀 배열*주1) 

 

통신 케이블 커넥터 

전면 기준, 

D-SUB 15 Pin 

male(수, 볼록) 

CD 1 

 

 

 

1 CD 

 

통신 케이블 커넥터 

전면 기준, 

D-SUB 9 Pin 

male(수, 볼록) 

RD 2 2 RD 

SD 3 3 SD 

DTR 4 4 DTR 

SG 5 5 SG 

DSR 6 6 DSR 

RTS 7 7 RTS 

CTS 8 8 CTS 

 9 9 RI 

*주1) 핀 배열은 케이블 접속 커넥터의 접속면에서 본 것 입니다. 

 

(C) XTOP/ATOP COM 1 포트 ( 6핀) 

XTOP/ATOP COM 1 포트 
케이블 접속 

외부 장치 

핀 배열*주1) 신호명 핀번호 핀번호 신호명 핀 배열*주1) 

 

통신 케이블 커넥터 

전면 기준, 

D-SUB 6 Pin 

male(수, 볼록) 

 1  1 CD 

 

통신 케이블 커넥터 

전면 기준, 

D-SUB 9 Pin 

male(수, 볼록) 

RD 2 2 RD 

SG 3 3 SD 

 4 4 DTR 

 5 5 SG 

SD 6 6 DSR 

  7 RTS 

  8 CTS 

  9  

*주1) 핀 배열은 케이블 접속 커넥터의 접속면에서 본 것 입니다. 
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5.2 케이블 표 2 

 

■ 1 : 1 연결 
 

(A) XTOP COM 2 포트(9핀) 

XTOP COM2 
케이블 접속 

외부 장치 

핀 배열*주1) 신호명 핀번호 핀번호 신호명 핀 배열*주1) 

 

통신 케이블 커넥터 

전면 기준, 

D-SUB 9 Pin 

male(수, 볼록) 

RDA 1  1  

 

통신 케이블 커넥터 

전면 기준, 

D-SUB 15 Pin 

male(수, 볼록) 

 2 2 T(A) 

 3 3  

RDB 4 4 R(A) 

SG 5 5  

SDA 6 6  

 7 7  

 8 8 GND 

SDB 9 9 T(B) 

 
10  

11 R(B) 

*주1) 핀 배열은 케이블 접속 커넥터의 접속면에서 본 것 입니다. 
 

(B) XTOP COM 2 포트(15핀) 

XTOP COM2 
케이블 접속 

외부 장치 

핀 배열*주1) 신호명 핀번호 핀번호 신호명 핀 배열*주1) 

 

통신 케이블 커넥터 

전면 기준, 

D-SUB 15 Pin 

male(수, 볼록) 

– 1  1  

 

통신 케이블 커넥터 

전면 기준, 

D-SUB 15 Pin 

male(수, 볼록) 

(생략) 2 T(A) 

3  

4 R(A) 

5  

– 10 6  

RDA 11 7  

RDB 12 8 GND 

SDA 13 9 T(B) 

SDB 14 10  

SG 15 11 R(B) 

*주1) 핀 배열은 케이블 접속 커넥터의 접속면에서 본 것 입니다. 
 

(C) ATOP COM 2 포트 ( 터미널 블록 5 pin ) 

XTOP COM2 
케이블 접속 

외부 장치 

핀 배열*주1) 신호명 핀번호 신호명 핀 배열*주1) 

 

통신 케이블 커넥터 전면 기준 

터미널 블록 5 Pin 

RDA  1  

 

통신 케이블 커넥터 

전면 기준, 

D-SUB 15 Pin 

male(수, 볼록) 

RDB 2 T(A) 

SDA 3  

SDB 4 R(A) 

SG 5  

 6  

7  

8 GND 

9 T(B) 

10  

11 R(B) 

*주1) 핀 배열은 케이블 접속 커넥터의 접속면에서 본 것 입니다 
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6. 지원 어드레스 

TOP에서 사용 가능한 디바이스는 아래와 같습니다.  

CPU 모듈 시리즈/타입에 따라 디바이스 범위(어드레스) 차이가 있을 수 있습니다. TOP 시리즈는 외부 장치 시리즈가 사용하는 최대 

어드레스 범위를 지원합니다. 사용하고자 하는 장치가 지원하는 어드레스 범위를 벗어 나지 않도록 각 CPU 모듈 사용자 매뉴얼을 

참조/주의 하십시오. 

 

 비트 어드레스 워드 어드레스 32 bits 비고 

입력 릴레이 

*주1) 

I00000.0 – 

I00127.7 

E00000.0 – 

E00127.7 

IW00000 – 

IW00126 

EW00000 – 

EW00126 

H/L 

*주4)주5) 

쓰기 불가 

출력 릴레이 

*주2) 

Q00000.0 – 

Q00127.7 

A00000.0 – 

A00127.7 

QW00000 – 

QW00126 

AW00000 – 

AW00126 
쓰기 불가 

데이터 블록 
DB00001 : DBX00000 – 

DB65535 : DBX65533.7 

DB00001 : DBW00000 – 

DB65535 : DBW65532 
— 

내부 메모리 M00000.0 – M00511.7 MW00000 – MW00510 쓰기 불가 

타이머*주3) — T00000 – T00255 쓰기 불가 

카운터*주3) — C00000 – C00255 Z00000 – Z00255 쓰기 불가 

*주1) Input Device(I, IW)는 CPU Type에 따라 내장  I/O에 종속 되어 IW0 ~ IW2의 주소에 쓰기 입력이 안될 수 있다. PLC 매뉴얼을 

참조하시오. 

*주2) Output Device(Q, QW, QD)는 Run Mode에서만 값 쓰기가 가능 합니다. STOP Mode 일 경우 출력 값은 Reset 됩니다. 

*주3) Read 전용 디바이스 

*주4) 워드 디바이스에 대해 32bit Data가 16bit씩 High/Low 순으로 저장 됩니다. 

(Example) VW00000 (32bit data, 0x12345678)  VW00000(16bit, 0x1234) VW00002(16bit, 0x5678) 

*주5) 32BIT address 사용 시, “워드 스왑”기능을 체크 합니다. 

 

 

 


